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Copyright

The 2014 Drake Software Manual Supplement: Charities and Non-Profits, Drake Tax 
Software, and any other related materials are copyrighted material. All rights are 
reserved by Drake Enterprises, LTD, including all ownership rights. This document, 
associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and repro-
duce the material in this document in an unaltered form only for your personal, non-
commercial use or for non-commercial use within your organization. Copyright, 
trademark, and other proprietary notices may not be removed.

© 2014 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, 
there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, 
assumes no liability for damages or claims resulting from the use of the information 
contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake 
Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered 
trademarks of their respective companies.
ii Tax Year 2014



Drake Software User’s Manual Supplement: Charities
Table of Contents

What’s New in Drake for Charities and Non-Profits . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Form 3115  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Schedule A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Schedule H . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Missing IDs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
 Unlimited Forms 2848  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
New ACA Fields on Form 8941  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Safe Harbor Elections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Practice Management Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Getting Started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Creating a Return . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Updating a Prior-Year Return  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Schedule O . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Form 990-N . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Form 990-EZ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Form 990-EZ Screens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Form 990-PF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Form 990-PF Screens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Recommended Order for Completing Form 990-PF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Form 990-T . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Form 990-T Screens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Form 990. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Recommended Order for Completing Form 990 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N) . . . . . . . . . . . . . . . . . . . . . . . 11
Schedule R . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Part VII, Section A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Parts VIII, IX, and X  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Header Line G  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Parts III, V, VII, and XI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Schedule L, Transactions With Interested Persons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Part VI, Governance, Management, and Disclosure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Part I, Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Part IV, Checklist of Required Schedules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Schedules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Part II, Signature Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Filing an Extension . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Amending a Return . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Form 3115, Application for Change in Accounting Method. . . . . . . . . . . . . . . . . . . 23
Accessing Screens for Changing Accounting Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Tax Year 2014 iii



Drake Software User’s Manual Supplement: Charities
Form 3115 Screens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Safe Harbor Elections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Binary Attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
The PDF Attachment Process  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Printing Generated Documents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Using the PRNT Screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Suppressing/Forcing Items  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Overriding Other Setup Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Turn Off Autobalance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Electronic Filing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
IRS Error Reject Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v
iv Tax Year 2014



Charities and Non-Profits (990)

Data entry on a tax-exempt organization (990) return is the same as data entry on the 
1040. Help, shortcut keys, and navigation through data entry all function as they do in 
the 1040. See Drake Software User’s Manual: Tax Year 2014 for the basics of using 
the program. 

What’s New in Drake for Charities and Non-Profits

Drake programs its tax software according to the latest IRS rules and regulations. The 
2014 program reflects all IRS changes to credits and deductions, including discontinu-
ations. For specific details to the IRS’s changes, see the IRS instructions for individual 
forms for tax-exempt organizations.

For a complete list of all the changes the IRS has made to Forms 990, see the “What’s 
New” section of the IRS instructions.

The following section explains the main change to the 990 package for 2014.

Form 3115 

Form 3115, Application for Change in Accounting Method, is now available in the 
990 package and eligible for e-file. See “Form 3115, Application for Change in 
Accounting Method” on page 23 for details of using Drake to file this form.

Schedule A

The biggest change to the 990 this year is to Schedule A. The IRS added Parts IV and 
V (Drake included screens A4 and A5 to accommodate these additions), and modified 
Part I, line 11. (In Drake, see screen A, Public Charity Status, for the changes to Part 
I, line 11).

The IRS has also clarified the instructions for Schedule A, Part II, allowing an organi-
zation to complete Part II even if it selects a public charity box in Part I other than for 
section 170(b)(1)(A)(vi). See the IRS instructions for more information.
Tax Year 2014 1



What’s New in Drake for Charities and Non-Profits Drake Software User’s Manual Supplement: Charities
See “Schedule A” on page 18 for information on completing Schedule A in Drake.

Schedule H

Schedule H has also been changed by the IRS, in particular Part V, Section B, which 
requires reporting on hospital facilities. The organization must complete a Section B 
for each of its hospital facilities or facility reporting groups listed in Schedule H, Part 
V, Section A.

In Drake, Part V, Section B is completed on screen H5 (accessed from the Schedule 
H-R tab of the Data Entry Menu). Note that Part V, Section B, is divided into three 
screens: Part V-1, Part V-2, and Part V-3, accessed through the tabs at the top of 
screen H5.

Missing IDs

In the past, if the organization had dealings with individuals or organizations outside 
the United States—for instance, if the organization held bank accounts in foreign 
countries—and these organizations or individuals did not an ID number, then you 
typed FOREIGNUS into the identification number field on a Drake screen. If the for-
eign person or organization had applied for an SSN or EIN but had not yet received an 
ID number, then you would have typed APPLD FOR in the ID field.

Now, to help avoid a data-entry error that might lead to an IRS reject, Drake will auto-
fill many of the identification number fields in the program. For instance, on screen 
3115, type F into the ID Number field and FOREIGNUS is automatically entered 
(see Figure 1), or type A and APPLD FOR appears.

Figure 1: FOREIGNUS is autofilled in the ID Number field of certain screens

 Unlimited Forms 2848

You can now enter an unlimited number of representatives on the redesigned 2848 
screen when filling out Form 2848, Power of Attorney. When you need another 2848 
screen to enter information on another representative, press PAGE DOWN.

New ACA Fields on Form 8941

Fields were added to the 8941 screen to allow you to complete the two new lines at the 
top of Form 8941, Credit for Small Employer Health Insurance Premiums. These new 
2 Tax Year 2014
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lines, added by the IRS, determine if the organization provided health care coverage 
for its employees as mandated by the Affordable Care Act, and determines if the orga-
nization is eligible to use Form 8941.

Safe Harbor Elections

A check box was added to screen 4562 to apply a small taxpayer Safe Harbor election 
to a building listed in the Description field. An election statement will be produced 
and the building description as entered in the Description field will be included in the 
election statement.

Two other elections are now available from the Elections drop list on the ELEC 
screen:

• Sec. 1.263(a) - 1(f) de minimis safe harbor election

• Sec. 1.263(a) - 3(n) Election

Election statements are generated with the return.

The Sec. 1.263(a) - 3(h) election can be made from either the ELEC screen or the 
4562 screen. See “Safe Harbor Elections” on page 32 for more.

Practice Management Tools

For details on additions and enhancements to Drake’s practice management tools—
such as the e-mail program, the letters and billing editor, and the Scheduler—see the 
Drake Software User’s Manual: Tax Year 2014. 

Getting Started

Some early tasks you may need to perform when getting started on a 990 return 
include creating a return (for new clients) or updating a return (for existing clients).

Creating a Return

To create a new return in Drake:

1. From the Home window, click Open/Create (or select File > Open/Create 
Returns, or press CTRL+O).

2. In the Open/Create a New Return dialog box, enter the organization’s nine-digit 
identification number.

3. Click OK. Click Yes when asked if you want to create a new return.

4. In the New Return dialog box, select Tax Exempt - 990 and enter the organiza-
tion’s name.

5. Click OK.

NOTE
Use blank forms to help clients collect tax-related data you will need. To 
access blank forms, go to Tools > Blank Forms and select the Tax-
Exempt tab. Select a form from the list and click Print.
Tax Year 2014 3
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Screen 1 of the return is displayed. You can now begin entering header information for 
the organization.

Updating a Prior-Year Return

If you prepared the organization’s tax return last year, you must update it for 2014.

Prior-year returns can be updated in three ways:

• A single return (updated one at a time) using Last Year Data > Update Clients 
2013 to 2014 (recommended)

• When you open an existing return from a prior year for the first time in the 2014 
program and are prompted to update it

• With all other returns in the program using Last Year Data > Update Clients 
2013 to 2014 (not recommended)

Drake recommends using the first option (updating returns individually) to ensure that 
you update only those items in a return that you want updated.

Schedule O

Use screen O to provide narrative information for Schedule O and for other schedules. 
Where in the return such information flows depends in part on which 990 type you’re 
working on, and in part on which item you select from the Schedule drop list on the O 
screen (see Figure 2 on page 5).

In general, the leading letter of the selection from the Schedule drop list indicates 
where the information will go. For instance, a selection of A1 through A9 generally 
sends the information to Schedule A, and selections of C1 through C7 generally sends 
the information to Schedule C, and so forth.

Select Z1 through Z11, however, and the information flows to Schedule O of the 990-
EZ. Select X for general statements and the information flows to the Schedule O and 
the attachment will be e-filed with an e-fileable return (990, 990-EZ, or 990-PF). A 
selection of AMD (for an amended return) also sends the information to Schedule O 
of either a 990 or 990-EZ return.

See “Schedule O, Supp. Info.” on page 20 for more information.

NOTE
Header information for all forms is completed on screen 1. For informa-
tion on specific fields in screen 1, see “Header Information (Forms 990, 
990-EZ, 990-PF, 990-T, 990-N)” on page 11.

NOTE
If you attempt to open a prior-year 990 return that was marked as “final” 
the previous year, the program informs you that the return was marked 
as final before it prompts you to proceed.
4 Tax Year 2014
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Figure 2: A selection beginning with Z will flow to the Schedule O of the 990-EZ

Form 990-N

Form 990-N, Electronic Notice (e-Postcard) for Tax-Exempt Organizations Not 
Required to File Form 990 or 990-EZ, is required for certain small tax-exempt organi-
zations.

To file the e-Postcard using Drake, go to screen 1 for the organization and take the fol-
lowing steps:

1. Under the General Information heading, select N - Form 990-N from the Form 
drop list (item #1 in Figure 3).

Figure 3: Begin by selecting N - Form 990-N from the Form drop list on screen 1.

2. At the bottom of the General Information section, mark the 990-N Only check 
box to indicate that the organization’s gross receipts are normally not more than 
$50,000 (item #2 in Figure 3).

3. Go to the OFF screen and complete the Name and Title fields, enter an address 
(or select the Use entity address check box), and for at least one officer, select 
Principal officer.

NOTE The SCH2 screen in a 990-PF return is the same as the O screen in the 
990 and 990-EZ returns.
Tax Year 2014 5
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Once any EF messages have been eliminated, the 990-N information can be e-filed. A 
“Form 990-N Information” page (“990_N” in View mode) will be generated with the 
return for informational and bookkeeping purposes.

Form 990-EZ

Certain organizations can file Form 990-EZ, Short Form Return of Organization 
Exempt From Income Tax, instead of Form 990. If an organization’s gross receipts 
(total amounts received from all sources during its annual accounting period) are less 
than $200,000 and total assets at year-end are less than $500,000, it can file Form 990-
EZ instead.

Form 990-EZ Screens

The following screens are specifically provided for completing Form 990-EZ. They 
are grouped under the 990-EZ only heading of the Form 990/990EZ tab.

Form 990-PF

Form 990-PF must be filed by certain exempt private foundations; see the IRS Form 
990-PF instructions for specific information on who must file this form.

NOTE For information on signing a return prior to e-filing, see “Part II, Signa-
ture Block” on page 21.

Table 1: 990-EZ Screens Under Form 990/990EZ Tab

Screen Title/Section on Form 990-EZ

21 Part I, Revenue and Expenses

22 Parts II and III, Balance Sheet/Accomplishments

23 Part V, Other Information, Page 1

24 Part VI, Section 501(c)(3) Only

O Schedule O, Supplemental Information

SCH3 Other Items

SCH5 Part I, Line 5c

SC21 Unreported Activities

SC40 Part I, Grants and Similar Amounts Paid

SC42 Part II, Other Assets/Liabilities

NOTE For information on signing a return prior to e-filing, see “Part II, Signa-
ture Block” on page 21.
6 Tax Year 2014



Drake Software User’s Manual Supplement: Charities Form 990-PF
Form 990-PF Screens

The 990-PF–specific screens are located under the Form 990PF tab (Figure 4).

Figure 4: Form 990PF tab in Drake (partial menu)

Several screens, such as screen 1, the DEPR, IND, and OFF screens, and certain 
schedule (SCH or SC) screens, can also be found elsewhere in the menu, as they 
apply for multiple forms and not just the 990-PF.

Recommended Order for Completing Form 990-PF

The IRS recommends completing Form 990-PF in the following sequence to limit 
jumping from one part of the form to another.

Table 2: Form 990-PF, Recommended Order

Seq. Section Screens Notes

1 IV 55

2 I and II 52, 53, 54 For required schedules, see “Part I Addi-
tional Schedules” and “Part II Additional 
Schedules” (following).

3 Heading 1, 51

4 III SCH3 Select item 5 or 6 from Line Number drop 
list and enter a description and amount.

5 VII-A 57 Use screen SC57 to create a schedule for 
controlled entities.

6 VIII OFF Use the IND screen to enter data for inde-
pendent contractors.

7 IX-A through X 59 If an explanation is required for line 1e of 
Part X, use screen SC59, Reduction Expla-
nation.

8 XII, lines 1–4 60 Line 4 is calculated automatically in Drake.

9 V and VI 56

10 XII, lines 5–6 n/a Calculated automatically in Drake.

11 XI 60

12 XIII 61
Tax Year 2014 7
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Part I 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part I (#2 in 
Table 2):

• Line 6a (Net gain or loss from sale of assets not on line 10) — Use screen SCH5.

• Line 10 (Gross profit or loss) — Use screen SCH7.

• Line 11 (Other income) — Use screen SC50 for subsidiary schedule.

• Line 18 (Taxes) — Use screen SC50 (when required).

• Line 19 (Depreciation) — Use screen DEPR for depreciation schedule. (The lines 
for Net Investment income and Adjusted net income on the DEPR screen are 
required for columns B and C of page 1 of Form 990-PF.)

• Line 23 (Other expenses) — Use screen SC50 for subsidiary schedule; use screen 
DEPR for amortization schedule. (The lines for Net Investment income and 
Adjusted net income on the DEPR screen are required for columns B and C of 
page 1 of Form 990-PF).

Part II 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part II (#2 
in Table 2 on page 7):

• Line 6 (Receivables due from officers, directors...) — Use screen SC14 (when 
required).

• Line 7 (Other notes/loans receivable) — Use screen SC14 (This produces state-
ment STM 135) and/or screen SCH3 (This produces statement STM 113).

• Lines 10a – 10c (Investments) — Use screen SC54.

• Line 11 (Investments – land, buildings...) — Use screen SC53 for subsidiary 
schedule (when required).

• Line 13 (Other investments) — Use screen SC53 for subsidiary schedule.

• Line 15 (Other assets) — Use screen SC53 for subsidiary schedule.

• Line 20 (Loans from officers, directors...) — Use screen SC55 (when required).

• Line 21 (Mortgages and other notes payable) — Use screen SC55.

• Line 22 (Other liabilities) — Use screen SC53 for subsidiary schedule.

Using 
Screen SCH2

Screen SCH2, General Explanation Attachment, allows you to attach explanations for 
certain parts of the Form 990-PF.

It is necessary to identify which part of the form is to be associated with the attached 
statement. To select a section of a form, choose an option from the Schedule drop list 

13 VII-B 58

14 XIV – XVII 62–66

Table 2: Form 990-PF, Recommended Order

Seq. Section Screens Notes

NOTE
This information on completing Form 990-PF is also available from 
the FAQ screen, item K (“Recommended Order for Completing Form 
990-PF”).
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Drake Software User’s Manual Supplement: Charities Form 990-T
at the top of screen SCH2. Next, write an explanation in the Explanation field. Press 
PAGE DOWN as needed for additional attachments. Note that there is a 5,000-character 
limit for e-filing.

Form 990-T

Form 990-T, Exempt Organization Business Income Tax Return, is used for:

• Reporting unrelated business income and tax liability

• Reporting proxy tax liability

• Claiming a refund paid by either a regulated investment company (RIC) or a real 
estate investment trust (REIT) on undistributed long-term capital gain

• Requesting a credit for certain federal excise taxes that have been paid

• Claiming Form 8941 credit for small-employer health insurance premiums

Based on the items listed above, an organization may need to complete Form 990-T in 
addition to its 990, 990-EZ, 990-PF, or 990-N return. See Form 990-T instructions to 
determine if an organization is required to file Form 990-T.

Form 990-T cannot be e-filed.

Form 990-T Screens

All 990-T–specific screens are located under the Form 990T tab (Figure 5).

Figure 5: Form 990T tab

NOTES

The SCH2 screen can be used for other 990 return types. Note that 
screens O (for Schedule O, Supplemental Information) and SCH2 
are the same. See “Schedule O” on page 4 for more information.

If X (General explanation attachment) is selected from the 
Schedule drop list, the attachment will be e-filed with an e-fileable 
return (990, 990-EZ, or 990-PF).

NOTE
Screen 80 must include a selection for item G (organization type) in 
order for Form 990-T to be produced correctly with the appropriate tax 
calculated.
Tax Year 2014 9
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Form 990

A tax-exempt organization under section 501(a) must file Form 990 if it has either:

• Gross receipts of $1 million or more

• Total assets of $2.5 million or more at the end of the tax year

For more information on who must file Form 990, see the Form 990 instructions pub-
lished by the IRS.

Recommended Order for Completing Form 990

The sequence shown in Table 3 is suggested as an efficient method for completing a 
return for a tax-exempt organization. In general, complete the core form first, and then 
complete—alphabetically—Schedules A through O and Schedule R, except as speci-
fied in Table 3. This order limits the need to jump back and forth from one part of the 
form to another, as certain later parts are required in order to complete earlier parts.

Table 3: Form 990, Recommended Order

Seq. Section Screens Notes

1 A – F; H(a) – M 
(heading)

1 This is the “Heading” section of Form 
990; line M is completed automatically 
based on resident state entered.

2 Schedule R R, R2, R3 Determine related organizations, disre-
garded entities, and joint ventures for 
which reporting will be required. (See 
Sch. R instructions; Form 990 instruc-
tions, Appendix F, Disregarded Entities 
and Joint Ventures).

3 Part VII, Section A OFF

4 Part VIII, IX, and X 8, 9, and 10

5 Header line G 1 Completed automatically in Drake

6 Parts III, V, VII, and 
XI

3, 4, 6, IND, 11

7 Schedule L L Complete if required; see Schedule L 
instructions.

8 VI 7 Transactions reported on Schedule L 
are relevant to determine independence 
of members of the governing body under 
Form 990, Part VI, line 1b.

9 I 2 Complete based on information derived 
from other parts of the form.

10 IV 5 Complete this section to determine 
which schedules must be completed.
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Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N)

Use screen 1 to fill out the header section for a tax-exempt organization. Complete all 
applicable fields. Enter the organization’s ID number, name, address, and telephone 
number at the top of screen 1.

Foreign 
Address

If the organization has a foreign address, fill out the applicable fields in the Foreign 
ONLY section of screen 1.

Type of Form To indicate which form the organization is filing, select an option from the Form drop 
list in the General Information section of screen 1. (See Figure 3 on page 5 and 
Figure 6 on page 12.) If the only return being prepared is a 990-T and its related 
forms, mark the 990-T only box.

Form 
Columns

Screen 1 has separate columns indicating the header boxes for Forms 990, 990-EZ, 
and 990-PF. For example, the “Exemption application pending” check box on screen 1 
(item #1 in Figure 6) puts an “X” in box B of Forms 990 and 990-EZ, or an “X” in box 
C of Form 990-PF. Note that not all questions are required for all forms (item #2 in 
Figure 6 on page 12).

11 Schedule O and 
any other applica-
ble schedules

Schedules A – 
G and Sched-
ules H – R tabs

12 II PIN; Setup info See “Part II, Signature Block” on 
page 21.

Table 3: Form 990, Recommended Order

Seq. Section Screens Notes

NOTE
Header information to be completed first are items A through F and 
H(a) through M. The Gross receipts field (header item G on the 990) is 
completed automatically.

NOTES

Foreign address fields are locked to keep incorrect address data 
from being entered. Click the field to unlock foreign address fields 
throughout the return. Close the return and re-open it to re-engage 
the lock for unused screens.

To use the foreign address fields, enter in the first field the name of 
the foreign province or state, as appropriate. Select the appropriate 
foreign country from the drop list, and then enter the postal code, if 
appropriate.
Tax Year 2014 11
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Figure 6: Screen 1 shows header labels for different forms (1);
not all questions are required for all forms (2); link to SCH4 (3).

Affiliate 
Listing 

(990 Only)

If the 990 is a group return filed for affiliates, but not all affiliates are included, a list 
of affiliates must be attached to the return. Screen SCH4 is available for this purpose 
and includes fields for affiliate name, address, and EIN. Click the SCH4 link on 
screen 1 (item #3 in Figure 6). 

Tax Year The program uses the current calendar tax year (beginning January 1 and ending 
December 31) by default. If the organization uses a fiscal year, enter the beginning 
and end dates in the If not calendar year box on screen 1 (Figure 7).

Figure 7: If not calendar year box on screen 1

Schedule R

Once you have completed the header information on screen 1, the IRS recommends 
completing Schedule R, Related Organizations and Unrelated Partnership. Schedule R 
is used to submit data regarding the organization’s relationships with other organiza-
tions, both taxable and tax-exempt. The program has three screens for Schedule R, 
listed in Table 4.

NOTE
The default data for the Name Control field on screen SCH4 is the 
four-letter code used by the IRS to match the information to the affili-
ate. This is an override field and must be completed if the name of the 
affiliate has changed since the entity’s last filed return.

Table 4: Schedule R Screens

Screen Sections of Schedule R Covered

R Schedule R, Parts I (Disregarded Entities), II (Related Tax-Exempt Organiza-
tions), and III (Related Organizations Taxable as a Partnership)
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To enter more entities, press PAGE DOWN to access new, blank fields.

Part VII, Section A

Once you have completed Schedule R, the IRS recommends completing Part VII, Sec-
tion A (“Compensation of Officers, Directors, Trustees, Key Employees, Highest 
Compensated Employees, and Independent Contractors”). Use the OFF screen to 
report this information, noting that information entered there is used to generate Part II 
of Schedule J (“Compensation Information”).

Parts VIII, IX, and X

Parts VIII, IX, and X of Form 990 comprise the financial statements for tax reporting 
purposes. These sections are accessed from screens 8, 9A, 9B, 10A, and 10B of the 
program.

Statement of 
Revenue

The program has two screens for Part VIII, Statement of Revenue. Go to screen 8 to 
complete items 1 and 3 through 10. Press PAGE DOWN (or click the Lines 2 11 screen 
hyperlink) to access fields for items 2 (“Program Service Revenue”) and 11 (“Miscel-
laneous Revenue”).

Statement of 
Functional 
Expenses

Use the organization’s normal accounting method to complete Part IX, Statement of 
Functional Expenses. Part IX should not be used to report expenses that belong on 
lines 6b, 7b, 8b, 9b, or 10b of Part VIII, Statement of Revenue.

R2 Schedule R, Parts IV (Related Organizations Taxable as a Corporation or 
Trust), V (Transactions With Related Organizations), and VI (Unrelated Orga-
nizations Taxable as a Partnership)

R3 Schedule R, Part V, Line 1

Table 4: Schedule R Screens

Screen Sections of Schedule R Covered

NOTE
Schedule R is not required for all organizations. For information on 
which aspects of Schedule R must be completed by an organization, 
see the IRS instructions for Schedule R, or click Screen Help on 
screens R, R2, and R3.

NOTE
Use the IND screen to enter information about compensation of inde-
pendent contractors. See “Compensation” on page 16 for more infor-
mation on the IND screen. 
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Part IX has two screens; to access the first screen (lines 1 though 14), go to screen 9A. 
To access the second screen (lines 15 through 26), go to screen 9B (or press PAGE 
DOWN from screen 9A).

Balance 
Sheet

All organizations must complete Part X. A substitute balance sheet cannot be used.

Part X has two screens: screen 10A (lines 1 through 15), and 10B (lines 17 through 
32). You can access screen 10B from screen 10A by pressing PAGE DOWN.

Header Line G

The program calculates line G (gross receipts) of the form header automatically, based 
on the information entered in on screen 8, (including the linked Line 2 11 Screen). 

Parts III, V, VII, and XI

Once you have completed Box G of the header, the IRS recommends completing Parts 
III, V, VII, and XI of Form 990 (screens 3, 4, 6, IND, and 11).

Purpose & 
Achievement

Part III, Statement of Program Service Accomplishments, requires that the organiza-
tion report its new, ongoing, and discontinued exempt purpose achievements, along 
with any related revenue and expenses.

In Drake, Part III of Form 990 consists of two screens. Use screen 3 to answer items 1 
through 3 (exempt purpose). Use screen 4 to complete the line 4 items (exempt pur-
pose achievements). From screen 3, you can access screen 4 by pressing PAGE DOWN.

Exempt 
Purpose

Use the Primary exempt purpose field on screen 3 to describe the organization’s 
mission. The mission statement can address why the organization exists, what it hopes 
to accomplish, whom it intends to serve, and activities it will undertake and where. 
See IRS instructions for further information on what constitutes a mission.

If you answer Yes to question 2 or 3 on screen 3, use Schedule O (screen O) to 
describe any new services or changes to services. From screen 3, you can click the 
Sch O Screen hyperlink to access this screen. See “Schedule O, Supp. Info.” on 
page 20 for more information about filling out Schedule O in the program.

NOTES

Screen Help in the program provides further instructions on this 
section. To access Screen Help, click the Screen Help button on 
the upper right corner. (You can also access Screen Help by right-
clicking the screen and choosing Screen Help from the right-click 
menu, or by pressing CTRL+ALT+? from the 9A or 9B screens).

For additional information, see the IRS instructions.

NOTE
Some end-of-year amounts require separate schedules. Screens for 
these schedules can be accessed by clicking the applicable links on 
screens 9A, 9B, 10A, 10B, and 11.

NOTE If the organization does not have a mission that has been adopted by 
its governing body, type None as the Primary exempt purpose.
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Exempt 
Achievement

Enter expenses, revenue, and a description of the exempt purpose achievements on 
screen 4. Examples of exempt achievements include:

• Providing charity care under a hospital’s charity care policy

• Providing higher education to students under a college’s degree program (the 
number of students served must be indicated)

• Making grants or providing assistance to individuals who were victims of a natu-
ral disaster

• Providing rehabilitation services to residents of a long-term care facility

Acceptable exempt achievements do not include any achievement not substantially 
related to the accomplishment of the organization’s exempt purpose (other than by 
raising funds).

To enter a description that exceeds the allowed number of characters on screen 4, 
press PAGE DOWN and continue the description. There is no need to re-enter the infor-
mation in the top section of the screen. If the description takes up more space than is 
allowed on the printed return, the program will generate it on a separate SERVICES 
page. (See Figure 8.)

Figure 8: Part III of Form 990 references a SERVICES page for descriptions
that are too long to be printed on the actual 990 form.

To enter another achievement, press PAGE DOWN and mark the box labeled Mark this 
box if starting a new description. The second description entered is shown (or refer-
enced on a SERVICES page, if applicable; see Figure 8) in section 4b of Part III. A 
third description is printed or referenced in section 4c. Additional descriptions are 
shown on a SERVICES page generated with the return.

Other IRS 
Filings

Part V, Statements Regarding Other IRS Filings and Tax Compliance, is used to show 
the organization’s compliance with the requirements of other federal tax laws for 
reporting and substantiation. Use screen 6 in the program to enter data for Part V. In 

NOTE The Program service code drop list on line 4 of screen 4 is not used.

NOTE
The exempt achievement description has a 5,000–character limit for 
e-filing; if the description exceeds 9,000 characters, the return must 
be paper-filed.
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Drake, Part V consists of two screens: use screen 6 to answer items 1 through 6b; 
press PAGE DOWN from screen 6 to access items 7 through 14b.

Compen-
sation

Part VII reports compensation paid to officers, directors, trustees, key employees, 
highest-compensated employees, and independent contractors. For Form 990, 990-EZ, 
or 990-PF, use the OFF screen (for officers, etc.) and the IND screen (for independent 
contractors) to enter this information.

The OFF screen also has fields for entering an officer address, “books in care of” 
information, and an indication of whether the specified officer signs the return. The 
IND screen has fields for name and address, type of service, and compensation, and a 
field to enter the number of contractors paid more than $100,000 ($50,000 for 
Form990-PF) in reportable compensation.

Reconcili-
ation of Net 

Assets

Enter the amount of changes in net assets or fund balances that occurred during the tax 
year on line 9 line of screen 11. These would include items such as prior-period adjust-
ments and changes in accruals.

Explain the changes on screen O, selecting code O26 in the Schedule drop list.

Financial 
Statements & 

Reporting

Part XII, Financial Statements and Reporting, is used for reporting information on the 
organization’s accounting methods and financial statements. The accounting method 
(line 1 of Part XII) is pulled from the method indicated on screen 1. Use screen 11 to 
answer all other items for Part XII.

Schedule L, Transactions With Interested Persons

Screen L contains fields for completing Parts I through IV of Schedule L, Transac-
tions With Interested Persons. All or part of Schedule L may be required for certain 
organizations that file Forms 990 or 990-EZ. Schedule L is used for the following pur-
poses:

• Reporting information on certain financial transactions or arrangements between 
the organization and disqualified persons under section 4958 or other interested 
persons

• Determining whether a member of an organization’s governing body is an inde-
pendent member for purposes of Form 990, Part VI, line 1b (“Enter the number of 
voting members who are independent”)

For information on which organizations must complete all or part of Schedule L, click 
Screen Help on the screen L, or consult the IRS instructions.

Part VI, Governance, Management, and Disclosure

Part VI, Governance, Management, and Disclosure, requests information regarding 
the governing body and management governance policies and disclosure practices. 
Although federal tax law generally does not mandate particular management struc-

NOTE See new instructions provided for lines 5, 6, and 8.
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tures, operational policies, or administrative practices, every organization is required 
to answer each question in Part VI.

Use screen 7 to access fields for Section A of Part VI. Press PAGE DOWN to access 
Sections B and C. If additional information is required for Part VI, use Schedule O 
(screen O; see “Schedule O, Supp. Info.” on page 20). O Screen links are available on 
parts of screen 7.

Part I, Summary

The summary section of Form 990 is for information regarding the mission, activities, 
and financial results of the organization. Use screen 2 to complete Form 990 Part I, 
Summary. (Line 1 of the “Summary” section of Part I flows from screen 3, line 1, Pri-
mary exempt purpose.) 

Number of 
Volunteers

Enter the number of full-time and part-time volunteers who provided volunteer ser-
vices to the organization during the reporting year. A reasonable estimate is acceptable 
if an exact number is not known. If the organization wishes to provide an explanation 
of how the number was determined, use Schedule O (screen O in the program; see 
“Schedule O, Supp. Info.” on page 20).

Line 7b If the organization is not required to file Form 990-T, enter a zero (0) for line 7b.

Lines 8–17 Prior-year amounts are updated automatically from the previous year’s return. These 
amounts can be entered or edited on screen 2.

Part IV, Checklist of Required Schedules

An organization uses Part IV, Checklist of Required Schedules, to determine which 
schedules must be completed and filed with the tax return. In Drake, two screens con-
tain fields for Part IV. Open screen 5 to access fields for lines 3 through 24d. Press 
PAGE DOWN from screen 5 to access fields for lines 25a through 37.

Schedules

Use the Schedules A – G and Schedules H – R tabs to access schedules. Click a 
schedule letter or title to open the screen for that schedule. Specific schedules can also 
be accessed using hyperlinks within screens. (Figure 9 on page 18)
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Figure 9: Screen 5 links to schedules

Schedule A Use Schedule A, Public Charity Status and Public Support, with Form 990 or Form 
990-EZ to provide information regarding public charity status and public support.

Use the following screens to enter data for Schedule A:

• Screen A (Part I, Reason for Public Charity Status; required by all organizations 
filling out Schedule A.)

• Screen A2 (Part I, Line 11, Information about Supported Organizations)

• Screen A3 (Parts II and III, Support Schedules)

• Screen A4 (Part VI, Supporting Organizations)

• Screen A5 (Part V, Type III Non-Functionally Integrated 509(a)(3) Supporting 
Organizations)

Schedule B, 
Contributors 

Use Schedule B, Schedule of Contributors, with Form 990, Form 990-EZ, or Form 
990-PF to provide information on certain contributions reported by the organization. 
Schedule B is required for contributions from at least one contributor in excess of 
$5,000. If there are no entries for the required Schedule B fields in the program, an EF 

NOTE
Some longer schedules require more than one screen to complete. 
For example, Schedule A consists of screens A, A2, and A3. You can 
access screens A2 and A3 from the Schedule tab, or you can press 
PAGE DOWN from screen A to access subsequent screens.

NOTES

Schedule A is required. At a minimum, amounts must be entered 
for the current year—even if the amounts are zero. If there are no 
entries for Schedule A, an EF Message is generated upon calcula-
tion, and the return cannot be e-filed.

Field- and screen-level help resources within the program provide 
valuable supplemental information and tips for completing Sched-
ule A in Drake. Press F1 for field-level help. On screens A and A3, 
click Screen Help for screen-level help.

Screen A4 consists of two screens. From the first screen, press 
PAGE DOWN to access Sections B through E on the second 
screen.
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Message is generated and the return cannot be e-filed. In Drake, use screen B to enter 
Schedule B information.

Schedule C, 
Political & 
Lobbying

Schedule C is required for certain section 501(c) organizations and section 527 organi-
zations filing Form 990 or Form 990-EZ. Use the following screens for Schedule C:

• Screen C — Parts I-A, I-B, and I-C

• Screen C1 — Part I-C, line 5 (names, addresses, and EINs of 527 organizations to 
which payments were made)

• Screen C2 — Parts II-A and II-B

• Screen C3 — Parts III-A and III-B

See the IRS form instructions for who is required to file.

Schedule D, 
Financial 

Statements

Filers of Form 990 should use Schedule D to provide the required reporting for the 
categories listed in Table 5. This table also shows which screens in Drake are available 
for completing specific information.

Press PAGE DOWN to go to the next Schedule D screen.

To enter data for Parts VII through X, go to screen D4 and select the applicable part 
from the Part drop list (Figure 10 on page 20).

NOTES
Contributor information on Schedule B is not publicly disclosed.

If Schedule B is not required, mark the check box on line IV on the 
lower left side of screen 1.

Table 5: Schedule D: Items Covered, and Screens Used

Category
Section of 

Schedule D
Screen to Use 

in Drake

Donor-advised funds (DAFs) Part I D

Conservation easements Part II D

Certain art and museum collections Part III D2

Escrow accounts and custodial arrangements Part IV D2

Endowment funds Part V D3

Investments - Land, Buildings, Equipment Part VI D3

Investments - Land, Buildings, Equipment Part VI, line 1e 
(“Other”)

D1E

Supplemental financial information Parts VII through X D4

Supplemental financial statements Parts XI through XII D5

NOTE
Note that Part VI, line 1e (“Other”) requires a separate screen from 
the previous Part VI information. Click the Line 1e detail link on 
screen D3 or open screen D1E.
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Figure 10: Select the applicable part on screen D4 For parts VII through X.

Press PAGE DOWN to access a blank D4 screen and enter data for additional parts.

For information on completing Part XIII of Schedule D, see the “Schedule O, Supp. 
Info.” section, following.

Schedule O, 
Supp. Info.

The IRS provides Schedule O for filers who must include narrative information for 
specific lines. Use screen O to provide narrative information for Schedule O and for 
other schedules.

To use screen O:

1. Open the screen—available through the Form 990/990EZ tab, the Schedule H - 
R tab, or–as the SCH2 screen–from the Form 990PF tab. Various other screens 
feature an O screen hyperlink.

2. From the Schedule drop list of the Schedule O screen, select the schedule and 
line numbers to be addressed on the screen. In the example on Figure 11, the user 
has selected Escrow Account Liability in order to address Part IV, line 2b of 
Schedule D. 

Figure 11: Schedule drop list on screen O

3. Under Explanation, type the narrative information. Note that there is a 9,000-
character limit for e-filing.

NOTE Screen O allows you to enter narrative information for numerous 
schedules—not just for Schedule O.
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Press PAGE DOWN to open a blank screen O and add supplemental information for 
another schedule or line.

Data entered on screen O is printed in the supplemental information section of the 
specified schedule. For example, the narrative from Figure 11 on page 20 would be 
printed under Schedule D, Part XIII, “Supplemental Information” on page 4 of the 
990.

Part II, Signature Block

The signature block on Form 990 contains fields for up to two signatures:

• An officer of the organization

• The paid preparer (if applicable)

If e-filing, enter the paid preparer and organization officer PINs on the PIN screen.

Note about 
Preparer ID 

Generally, anyone who is paid to prepare the return must sign the return and fill in the 
other blanks in the “Paid Preparer’s Use Only” area of the return. An employee of a 
filing organization is not a paid preparer.

In order to have the preparer ID number (PTIN or SSN) printed in the applicable space 
on the return, the preparer must:

• Sign the return in the space provided for the preparer’s signature

• Enter the preparer information

• Give a copy of the return to the organization

Preparing 990 
returns in 

Drake

Any 990 returns (including 990-EZ, 990-PF, 990-N, and 990-T) prepared in Drake 
Software will have the preparer’s PTIN printed in the “Paid Preparer’s Use Only” sec-
tion of the return automatically.The only return in which the preparer’s SSN will be 
printed in the “Paid Preparer’s Use Only” section is one that meets these conditions:

• The Section 4947(a)(1) check box on screen 1 is marked

• Line 12a of Part 5, (screen 6, press PAGE DOWN) is marked “Yes” (for 990 return)

• Line 43 of screen 23 is marked (for 990EZ return)

• Line 15 of screen 57 is marked (for 990PF return)

NOTES

The codes for the O screen are preceded by the letter O.

To add a narrative explanation for an amended return, select AMD 
(located just before the O items in the drop list). See “Amending a 
Return” on page 23 for more on amending a return.

To add a general explanation attachment, select X (located at the 
bottom of the drop list).

IMPORTANT
The applicable ERO or preparer PIN must be entered in 
Setup > Preparer(s) or Setup > Firm(s) in order to e-file 
a tax return. For more information on setting up firm, pre-
parer, and ERO information in Drake, see Drake Soft-
ware User’s Manual: Tax Year 2014.
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• There is no PTIN entered for the preparer in Setup > Preparer(s) or no PTIN 
entered on the PREP screen.

Filing an Extension

Calendar-year returns are due on May 15, 2015. If an organization uses a fiscal year, 
the return is due by the fifteenth day of the fifth month after the accounting period 
ends. By filing Form 8868, an organization can extend the deadline three months (to 
August 15 for a calendar year return). Form 8868 can be used to apply for an addi-
tional three-month extension if the original three-month extension was insufficient.

Use the 8868 screen (available from the Other Forms tab) to apply for an extension. 
Select the applicable box at the top of the 8868 screen to indicate the type of extension 
being requested. (See Figure 12)

Figure 12: Select the type of extension being requested.

If requesting an additional extension, an explanation is required on the 8868 screen.

IMPORTANT

The IRS is not authorized to redact (delete) the paid pre-
parer’s SSN if the SSN is entered in the paid preparer’s 
block. Form 990 is a publicly disclosable document. Any 
paid preparer whose ID number must be listed on Form 
990 may wish to apply for and obtain a PTIN using Form 
W-7P. 

NOTES
Form 8868, Application for Additional Extension of Time to File an 
Exempt Organization return can be e-filed.

Once the extension is e-filed and accepted, to later e-file the return, 
first, go to the ESUM screen (accessible from the Miscellaneous tab of 
the Data Entry Menu) and delete the “A” from the ACK Code column.
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Amending a Return

Indicate an amended return in the General Information section of screen 1. Note that 
an explanation is required on screen O for an amended return.

To provide an explanation for an amended return:

1. Open screen O.

2. From the Schedule drop list, select AMD - Amended Return Information. This 
selection is located between the N and O items in the Schedule drop list, as shown 
in Figure 13.

Figure 13: The AMD selection is listed between the N and O selections.

3. Enter the explanation in the text box below the drop list. Character limit for e-fil-
ing is 9,000 characters.

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any material item. Form 3115 is eligible for e-file.

CAUTION
When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, 
you should archive the original to avoid losing previously sub-
mitted data. For more information on archiving returns, see 
“Archive Manager” in Chapter 6 of the Drake Software User’s 
Manual: Tax Year 2014.

IMPORTANT The amended return should include all information per-
taining to the return—not just the new or corrected data.
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Drake customers can fill out and e-file Forms 3115 and related schedules and attach-
ments for 990 returns. This section provides instructions for completing this form and 
related schedules and attachments in Drake.

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the Other Forms tab of 
the Data Entry Menu.

Figure 14: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in 
Figure 15 on page 25) that allows you to link a screen or attachment to a particular 
Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake. The first should be 1, the second 2, and so on. When using 

NOTES

In some cases, Form 3115 must still be paper-filed. See “Parts I 
and III,” starting on page 25, for details.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for 
general automatic change procedures, and to Rev Proc. 2015-14 
for a list of automatic changes to which the automatic change pro-
cedures in Rev. Proc. 2015-13 apply.
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other screens, such as the 311E or ATT screens, you can use those numbers to indicate 
which instance of Form 3115 the 311E or ATT screen should be associated with.

Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the 
first of five 3115 screens. These five screens are:

• Parts I, III (Form 3115, Parts I and III)

• Parts II, IV (Form 3115, Parts II and IV)

• A, B, C (Form 3115, Schedules A, B, and C)

• D - I, II (Form 3115, Schedule D, Parts I and II)

• D - III (Form 3115, Schedule D, Part III)

As shown in Figure 15 on page 25, you can access these 3115 screens by clicking a 
link at the top of any other 3115 screen.

Figure 15: Tab links on 3115 screen

The next few sections of this document provide instructions for completing the vari-
ous screens for Form 3115 (including Schedules A through D).

Parts I and III Use the Parts I, III screen to complete the following sections of Form 3115:

• General Information

• Part I, Information For Automatic Change Request

• Part III, Information For Advance Consent Request

General 
Information

Complete all applicable fields in the General Information section. Note that the 
fields for business activity and tax-year change are override fields (Figure 16). Com-
plete these fields only if you want to override the equivalent information entered on 
screen 1 or screen K.

NOTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.

NOTE Information should be entered in either the Part I section or the Part III 
section, but not both.
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Figure 16: Override fields in the General Information sections of the Parts I, III screen

On the Type of accounting method change being requested line, select Deprecia-
tion or amortization, or Financial products and/or financial activities. If request-
ing another method, describe it in the Other text box. (The text box is limited to 20 
characters.)

Part I From the drop list on line 1a, choose a Designated accounting method change num-
ber. If the method is not listed, enter the method on line 1b, in the Other text box.

Other resources include Drake’s Knowledge Base article 13402. (For information on 
using the Drake Knowledge Base, see Chapter 10 of Drake Software User’s Manual: 
Tax Year 2014.)

NOTE

For advance consent requests, state in the Other text box the type of 
method change being requested and a short description of the change 
(for example, LIFO to FIFO.)

For automatic change requests, these informational requirements are 
satisfied by properly completing Part I, lines 1a and 1b of Form 3115. 
(See “Part I,” following.)

IMPORTANT

The IRS issued Rev. Proc. 2014-16 to explain how tax-
payers can elect to automatically change their account-
ing methods in order to comply with provisions of the 
final capitalization regulations. Rev. Proc. 2014-54 fur-
ther explains how taxpayers can elect to automatically 
change their accounting methods for the disposition of 
property in order to conform with the regulations relat-
ing to the disposition of capital assets.
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If any of the scope limitations of section 4.02 of Rev Proc. 2008-52 apply, mark the 
Yes check box on line 2.

After answering 1a, 1b, and 2 in Part I - Information for Automatic Change 
Request, click the blue Parts II, IV tab at the top of the screen.

Part II In Part II – Information for All Requests, answer question 3 (see Figure 17 on 
page 27). If the answer is Yes:

• Ordinarily, the IRS will not consent to a request for a change in method of 
accounting for the applicant’s final tax year. If the applicant ceases to engage in 
the trade or business to which the desired change in accounting method relates or 
terminates its existence in the year of change, the applicant is ordinarily not eligi-
ble to make the change under automatic change request procedures unless the 
applicable section of the Appendix of Rev. Proc. 2011-14 or other applicable pub-
lished guidance states that section 4.02(5) of Rev. Proc. 2011-14 does not apply to 
the requested change in method of accounting. If the change is requested under 
the advance consent procedures, the IRS National Office will consider the reasons 
for the change in the applicant’s final year (see Part III, line 21) in determining 
whether to approve the requested change.

• See IRS Form 3115 instructions for details.

Figure 17: Automatic Change Request information

IMPORTANT

By answering Yes on line 2, you are stating that the 
Appendix of Rev. Proc. 2002-9 or the procedures in other 
published guidelines specifically state that the scope lim-
itations are applicable to the required accounting method 
change.

If you answer Yes on line 2, you must complete all the 
lines in Part II, Information for All Requests. (Click the 
Parts II,IV link at the top of the screen to access Part II.)

See Form 3115 instructions for more information.

NOTE Not all applicants are eligible to use the automatic change request pro-
cedures.
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Part III If this section of the Parts I, III screen is filled out, Form 3115 cannot be e-filed with 
the return. It must instead be paper-filed before submitting the return. A user fee (a 
check or money order payable to the IRS) must be included with the paper-filed form.

If the applicant qualifies for a reduced user fee, enter a check mark on line 23b and go 
to screen ATT2 to complete the attachment information for Part III, line 23b (located 
in the bottom half of the screen). Include the necessary information or certification 
required by Rev. Proc. 2013-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers Yes for 
line 18 (“Is change request allowed under automatic change?”) or No for line 22 (“All 
members of consolidated group use proposed method?”). Press F1 in a specific field 
for more information on attachment requirements. The method for attaching state-
ments in Drake is covered in “Binary Attachments” on page 33.

Multiple 
Accounting 

Method 
Changes

If requesting multiple automatic accounting method change requests on one Form 
3115, go to screen 3115 and in the Part 1–Information for Automatic Change 
Request section, make a selection from the drop list on line 1a, then use the drop lists 
below line 1a (see Figure 18) to select account method changes being requested.

Figure 18: Making multiple automatic accounting method change requests

On page 1 of Form 3115, the “Other” check box under “the type of accounting method 
change being requested” will be marked and a note indicating that multiple automatic 
change requests (“MULTI AUTO CHNG RQST”) have been made (#1 in Figure 19), 
and the designated change numbers of the requests appear in the “Description” field of 
Part 1 (#2 in Figure 19).

NOTES
See Appendix A of Rev. Proc. 2012-1 for more information. For more on 
applicants who must apply for advance consent, see the IRS Form 
3115 instructions.

Taxpayers filing under an automatic change request procedure do not 
pay a user fee.
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Figure 19: Accounting change requests noted on Form 311

Parts II and 
IV

In addition to the Multi-form code text box, the Parts II, IV screen consists of the 
Part II and Part IV sections, used to complete the following sections of Form 3115:

• Part II, Information For All Requests

• Part IV, Section 481(a) Adjustment

Applicants must complete both sections of this screen. For more information on each 
line (including instructions for any required attachments), press F1 in a specific field.

Part II, Line 12 Note that there is no field on the Parts II, IV screen for Part II, line 12. There is, 
instead, a link to screen ATT2. Fields for line 12, which should be completed if the 
applicant is changing only the accounting method for a particular item or items, are 
located in the top half of ATT2 screen. Use these fields to enter information on:

• The items being changed

• The applicant’s present and proposed methods for the items being changed

• The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the ATT2 screen is for completing Part III, line 23b. Only 
the top half (for Part II, line 12) must be completed for Part II, line 12.

Schedules A, 
B, and C

Use the A, B, C screen to complete the following sections of Form 3115:

• Schedule A, Change in Overall Method of Accounting (screen covers Part 1, 
Change in Overall Method)

• Schedule B, Change to the Deferral Method for Advance Payments

• Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part 
I, General LIFO Information, and Part II, Change in Pooling Inventories)

NOTE
Schedule A, Part II (Change to the Cash Method for Advance Consent 
Request) requires attachments and is not addressed on the A, B, C 
screen.
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Schedule A This section is required for all applicants filing to change their overall method of 
accounting. It requires the entry of amounts as they were at the close of the tax year 
preceding the year of the requested change.

The IRS requires a worksheet for lines 1a, 1c, 1d, 1e, and 1f of Schedule A. When you 
enter an amount on any of these lines in Drake, a CTRL+W worksheet is automatically 
opened, allowing you to begin entering the descriptions and amounts of multiple items 
for the worksheet. When you close a CTRL+W worksheet, the program returns to the 
original screen and displays the total in the field. The field is shaded (default is red) to 
indicate that a CTRL+W worksheet has been used. 

Schedule B This section has just two lines, both referring to the request for deferral for advance 
payments:

• Line 1 — Request change to the deferral method for advance payments (from sec-
tion 5.02 of Rev. Proc. 2004-34)

• Line 2 — Request change to the deferral method for advance payments (from sec-
tion 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

Schedule C This section has two parts:

• Part I (General LIFO Information) — This section is made up of attachment 
links. If any of the conditions on lines 1–6 match the entity’s situation, click the 
corresponding attachment link to access the ATT screen, where you can complete 
the required statement. (Select the corresponding line code from the Schedule 
drop list on the ATT screen.)

• Part II (Change in Pooling Inventories) — Enter the descriptions of the contents 
and the base years of the present and proposed pools. If any of the conditions on 
lines 2–4 match the entity’s situation, click the corresponding attachment link to 
access the ATT screen, where you can complete the required statement.

Schedule D, 
Parts I and II

Use the D - I, II screen to complete the following parts of Form 3115, Schedule D, 
Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, or 
Other Section 263A Assets:

• Part I, Change in Reporting Income From Long-Term Contracts

NOTE
Leave blank any lines that aren’t required for the entity’s application. 
Exclude amounts not attributable to the change in method of account-
ing—for example, amounts that correct a math or posting error, or that 
correct errors in calculating tax liability.

NOTE If nothing is entered in a Schedule A field, the program automatically 
displays the word “NONE” in the field on the generated form.
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• Part II, Change in Valuing Inventories Including Cost Allocation Changes

Schedule D, 
Part I

A long-term contract refers to any contract for the manufacture, building, installation, 
or construction of property that is not completed in the tax year in which it is entered 
into. Answer the questions in Part I that apply to the entity’s situation.

Schedule D, 
Part II

This section concerns changes in the identification and valuation methods of invento-
ries. Note that some lines require attachments. To access the ATT screen and complete 
a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Sched-
ule D. For information on completing individual lines, see the Form 3115 instructions.

Schedule D, 
Part III

Use the D - III screen to complete Part III (Method of Cost Allocation) of Form 3115, 
Schedule D. Part III is required for any entity submitting either Part I or Part II. Screen 
D - III consists of the following sections:

• Section A, Allocation and Capitalization Methods

• Section B, Direct and Indirect Costs Required to be Allocated

• Section C, Other Costs Not Required to be Allocated

Section A Click the D3-1 Attachment link (see Figure 20 on page 31) to attach a description of 
the present and proposed methods used to capitalize direct and indirect costs.

Figure 20: Link to ATT screen for attaching statements

Sections B 
and C

Sections B and C consist of a series of drop lists under a Present column and a Pro-
posed column. “Present” refers to the current accounting method, while “proposed” 
refers to the requested change in accounting methods. You should address only the 
items necessary; do not make a selection for any item for which an answer is not 
required for the entity’s situation.

NOTE
If an entity is currently using a LIFO inventory method or submethod 
and is changing to another LIFO inventory method or submethod, Part 
II of Schedule D is not applicable. Use Schedule C, Changes Within the 
LIFO Inventory Method, instead.

NOTE

If the entity is unable to furnish a copy of Form 970 (line 5a), the attach-
ment must include the following statement:

“I certify that to the best of my knowledge and belief (name of applicant) 
properly elected the LIFO inventory method by filing Form 970 with its 
return for the tax year(s) ended (insert date(s)) and otherwise complied 
with the provisions of section 472(d) and Regulations section 1.472-3.”
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For each item in sections B and C, you can:

• Select X — If you select X, the corresponding box on Form 3115 will be marked 
with an X. (See Figure 21.)

• Select B — If you select B, the corresponding box on Form 3115 will be left blank 
and an attachment will be required explaining why the line was left blank. (EF 
Messages will outline which statements are missing.

• Select nothing — If you select neither of the above options, “N/A” will appear in 
the corresponding box on Form 3115. No attachment is necessary for a box 
marked “N/A.”

Figure 21: X was selected for column 1, lines 1-3; B was selected for column 1, line 4;
nothing has yet been selected for any other line.

To attach a statement for section B or C, click the D3-2 Attachment link at the top of 
Section B (Figure 22 on page 32). A single statement may contain all necessary expla-
nations for sections B and C.

Figure 22: If any box is marked “B,” click the D3-2 Attachment link to open
the ATT screen and complete the fields for an attached statement.

Safe Harbor Elections

New for 2014: A check box was added to screen 4562 to apply a small taxpayer Safe 
Harbor election to a building listed in the Description field. An election statement 
will be produced and the building description as entered in the Description field will 
be included in the election statement.

NOTE This Safe Harbor election covers buildings only.
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See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

New Options 
on ELEC 

Screen

Two other elections are now available from the Elections drop list on the ELEC 
screen:

• Sec. 1.263(a) - 1(f) de minimis safe harbor election

• Sec. 1.263(a) - 3(n) Election

Election statements are generated with the return (Figure 23).

Figure 23: Election statement generated with ELEC screen selection

The Sec. 1.263(a) - 3(h) election can be made from either the ELEC screen or the 
4562 screen.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be in PDF for-
mat and attached to the return in order to be e-filed with it. Paper documents must be 
scanned into the computer to be attached.

Attach files through the PDF Attachments screen, accessible from the Electronic 
Filing section on the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF file to be attached

NOTES
This PDF–attachment feature is available in several packages in Drake. 
Some of the examples shown in this section are from other packages, 
but the feature works the same way in all packages.

Directions for attaching documents can also be found in the Screen 
Help of the PDF Attachments screen, and in item L of the FAQ screen.
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2. Informing the program that a PDF file will be sent with the return

3. Attaching the PDF file for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return. 

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Files in 

Drake

To indicate in the software that a PDF file will be sent with the return:

1. Open the return in Drake. From the Form 990/990EZ tab of the Data Entry 
Menu, click PDF, or type PDF in the selector field and press ENTER.

2. Fill out the columns on the PDF Attachments screen. See Table 6 for examples.

Table 6: PDF Attachment Window Columns

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF file is attached, the program generates an EF 
Message regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Files in Drake,” previously), there will be two PDF–
related items in the View/Print window:

• An EF MESSAGES alert (item #1 in Figure 24)

• An Attach PDF button on the toolbar (item #2 in Figure 24)

TIP It’s a good idea to use the DDM scanning feature for this step.

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 990

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Figure 24: The red MESSAGES page and the Attach PDF button

2. Click MESSAGES to view EF messages, including information on how to attach 
the required documents to the return.

3. Click Attach PDF (item 2 in Figure 24). The EF PDF Attachments window 
(Figure 25 on page 35) displays the information entered on the PDF Attachments 
window in data entry. A red X means the document has not been attached; a green 
check mark indicates an attached document.

Figure 25: The EF PDF Attachments window

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).
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Repeat for all documents with a red X. When all documents have been attached to a 
completed return, recalculate the return. If there are no EF messages, the return is 
ready to be e-filed.

Printing Generated Documents

In some instances, Drake generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. An EF message will state 
that attachments are required. You will then need to obtain and complete the state-
ments, scan them into the computer, save them as a PDF file, and attach them to the 
return.

Using the PRNT Screen

Use the PRNT screen (accessible from the Form 990/990EZ and Miscellaneous 
tabs) to override most program defaults.

Suppressing/Forcing Items

To suppress or force printing of certain items, go the PRNT screen and select the 
desired options.Selections override the options established in Setup. For more on set-
ting up options globally in Drake, see Drake Software User’s Manual: Tax Year 2014.

The following items can be “forced” from the PRNT screen (see Figure 26):

• Diagnostic summary report listing the forms calculated and providing a brief sum-
mary of the return

• Next-year depreciation listing for the organization

• Indication on the return that the organization has changed its accounting period

• Preparer’s name in the “Preparer’s signature” line for preparer and client copies of 
a return that has been e-filed

Figure 26: PRNT screen options

The following items can be suppressed from the PRNT screen of a 990 return (see 
Figure 26):

• Commas (in the amounts printed on the forms)
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• Columns B, C, and D of Form 990, Part IX, if the organization is not a 501(c)(3) 
or 501(c)(4) organization (Only Column A, Total expenses, would be generated 
for this section of Form 990.)

• Data for non-required fields on Form 990-T of gross receipts are $10,000 or less

Overriding Other Setup Options

Filing instructions (federal and state) and envelope coversheets (organization, IRS, 
and state) can be either forced or suppressed from the PRNT screen to override the 
global setting in Setup.

You can also enter the date to be printed on the return. In Setup > Options > Optional 
Items on Return, you can indicate if the return should have no date or if it should 
have the current system date. Use the PRNT screen to override the setup option 
choice for a return.

Turn Off Autobalance

Autobalance forces the balance sheet to balance for both the beginning- and end-of-
year amounts by adjusting net assets or fund balance.

The program makes the adjustments due to differences in the balance sheet. Incorrect 
data entry could cause these differences but they are usually the result of amounts 
being erroneously deleted or changed from the balance sheet screens. To reconcile the 
differences, it is best to compare the organization’s beginning and ending balance 
sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Electronic Filing

An organization has the option to e-file Form 990, 990-EZ, 990-PF, 990-N, and 
related forms, schedules, and attachments. If the organization files at least 250 returns 
of any type during the calendar year and has total assets of $10 million or more at the 
end of the tax year, it is required to e-file Form 990.

Steps for e-filing Form 990 are the same as for e-filing Form 1040. For detailed 
instructions on e-filing returns in Drake, see Drake Software User’s Manual: Tax Year 
2014.

NOTE
A default due date for filing is printed on all letters and filing instructions 
generated with a return. You can override the default date by entering 
an alternate due date in the Due date to print on letter and filing 
instructions field on the PRNT screen.

NOTE
A short period return cannot be filed electronically unless it is an initial 
return or a final return (one of those boxes is marked on screen 1.)

Form 990-T cannot be e-filed.
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To determine if an organization meets the $10 million asset test, use the amount of 
total assets at the end of the year (Form 990, page 11, line 16).

If an organization is required to e-file but does not do so, it is considered not to have 
filed its return. See Temporary Regulations section 301.6033-4T for more informa-
tion.

For additional information on the e-file requirement, visit the IRS website at 
www.irs.gov. Click the Filing tab, then from the menu on the left, click Charities & 
Non-Profits, and select e-file for Charities and Non-Profits.

IRS Error Reject Codes

If any of the following IRS error reject codes is generated when e-filing a 990 return, 
the preparer must contact the IRS for further information. The IRS e-Help Desk tele-
phone number is (866) 255-0654

F990-902-01: The EIN in the return must have been established as an exempt organi-
zation return filer in the e-file database.

F990-913-01: Tax-exempt status specified in Item I, must match data in the e-file 
database.

F990-913-01: The “Return Type” indicated in the return header must match the return 
type established with the IRS for this EIN.

R0000-922-01: Filer’s EIN and Name Control in the Return Header must match data 
in the e-file database, unless “Name Change” or “Name or Address Change” check 
box is marked, if applicable.
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